
   
My Study Bar 

My Study Bar is software that is available on every PC within Chester University campuses.  It is also 

software that can be freely downloaded and so it can also be used at home.  It is a toolbar which 

contains a number of applications that increase productivity of the student in one way or another.  

For a detailed introduction to this toolbar, look at: 

My Study Bar Website 

For students, this software has a shortcut on the desktop, for staff you can start it from the network 

applications drive: 

Network Applications (N:)\\SSG Software\MyStudyBar\MyStudyBar.exe 

For the table below, I have separated out all of the applications and arranged them in alphabetic 

order for reference.  I have then added enough information to introduce each application and try 

and show the student how the application can start to be used.  Full tutorials on each of the 

applications are available from the website link given above. 

Some applications have been developed further than the version in My Study Bar and this is 

normally the case when they have a separate website and different icon.  I have tried to include the 

website so the reader can decide whether to use the version in My Study Bar or to go to the website 

and download the latest version. 

Tool within MyStudyBar How to use 

Balabolka (Balabolka Website) is a Text-To-
Speech (TTS) application. 

 
My Study Bar has version 1.30 and the latest is 
2.11 from the website. 
 
Text can be read out using the voices that are 
already loaded in Windows or save the speech 
in a variety of audio formats. 
 

Once started, copy text to the bottom window 
and then position the cursor at the start of the 
text.  You can then use the ‘play’ button on the 
toolbar for the app to start to read the text. 
 
If you only want to hear some of the text, then 
just highlight the text you want to hear and 
press the ‘read selected text’ on the toolbar. 
 
In the file menu, there are options to record 
the text as audio files including adding header 
information, so the text can be played back at a 
later time. 
 
Unfortunately, the help text does not work on 
this version of the app. 

Hott notes (Hottnotes Website) is a simple, 
easy-to-use sticky notes software for Windows. 

 
My Study Bar has version 4.1 and the latest is 
4.1 from the website. 
 

When the application is started, the Hott notes 
icon sits in the Windows tray. 
 
To start, right click this icon, then choose  
New -> Note or Checklist Note or Scribble Note. 
 
The note appears as well as the configuration 
menu.  The date is in US format on the note 
and, unfortunately, you cannot change it.  The 
configuration menu allows the text to be 
changed to suit the user. 

http://eduapps.org/?page_id=7
http://www.cross-plus-a.com/balabolka.htm
http://www.hottnotes.com/
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Different formats of notes can be created such 
as Notes, lists and scribble version which are 
self-explanatory. 
 

LetMeType helps you enter text, but regardless 
of the program you use.  Running in the 
background, it analyses what you type.  

 
 
After some time it has collected enough 
information to guess a word after you have 
typed the first two or three letters.  A list of the 
most probable words is displayed, and you can 
select one with a single keystroke or just 
continue typing. 
 
My Study Bar has version 1.81 but the software 
appears to no longer to be supported. 
 

Once this app is started, it runs in the 
background and its behaviour is highly 
customizable.  The main settings page can be 
found here: 
 
File -> Settings… 
 
You can set the maximum number of 
suggestions and/or their frequency.  For skilled 
keyboard writers it is possible to limit the 
suggestions to long words with a high 
probability of occurring. 
 
Note that suggestions from this app appear in 
whichever software you are using.  It needs a 
lot of text to analyse before it can suggest 
meaningful options. 
 
There is an error with the help file so it is not 
available. 

Lingoes (Lingoes Website) is a dictionary and 
multi-language translation software providing 
results in over 80 languages.  It offers full

 
 
text translation, capture word on screen, 
translate selected text and pronouncing text, 
and abundant free dictionaries as a new 
generation dictionary and translation software. 
 
Lingoes offers users the quickest way to look up 
dictionaries and translation among English, 
French, German, Spanish, Italian, Russian, 
Chinese, Japanese, Korean, Swedish, Thai, 
Turkish, Vietnamese, Greek, Polish, Arabic, 
Hebrew and more over 80 languages.  
 

When choosing this option from My Study Bar, 
it says that ‘Lingoes has expired’ and gives the 
option to go to the website or to ‘Upgrade 
now’.  The ‘Upgrade now’ button does not work 
as the upgrade fails. 
 
If this functionality is required, then it is best to 
download a fresh version from the website. 
 
Once started, with the creative cursor 
translator, Lingoes automatically recognizes the 
word and its definition as soon as you move the 
cursor and point to any text, then press the 
configured hotkey.  It runs in the background 
and so does not disturb your current work. 

http://www.lingoes.net/en/translator/index.html
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Virtual Magnifier (Virtual Magnifier Website) 
for the screen that is used to look at text. 

 
My Study Bar has version 3.2.2 and the latest is 
3.7 from the website. 
 
The magnifier is highly configurable including 
changing the contrast of the text that it shows. 
 

Once started, the magnifier follows the mouse 
cursor.  To stop the magnifier, just click on the 
mouse and it will stop.  The app continues 
running in the task bar and so can easily be 
restarted, if required. 
 
To configure the magnifier, right click the icon 
in the Windows task bar and choose the option 
that you wish to amend. 

Mozilla Sunbird is a stand-alone calendar 
application but it is no longer supported.   

 
Nowadays, calendars are ubiquitous especially 
in mobile phones. 
 

If this application is started, then it complains 
that it is running from a read-only drive.  It will 
give the option to copy the calendar to another 
writeable drive but otherwise it will not start. 

Orato (fx-software Website) is a straight 
forward Text To Speech (TTS) application. 
 

 
All text input is carried out through the 
clipboard.  Settings allow Orato to read either 
on demand or automatically when new text is 
added to the clipboard.  Other options will 
display the text if required, with highlighting of 
the word or sentence being spoken.  Orato can 
either be installed to the hard disk or copied 
onto a pen drive for portable use. 
 

Once started, any text that is copied into the 
clipboard is read out by ‘Orato’.  It uses a voice 
that is already loaded on the PC such as 
‘Microsoft Anna’ although the speech rate of 
this voice can be amended. 
 
There is an error with the help as the help text 
is not displayed. 
 
There is another error when exiting as the .ini 
file cannot be updated because it running from 
a read-only disk.  It needs to be closed down 
from the task manager. 

RapidSet (fx-software Website) allows quick 
and easy changing of the background and font  

Once started, this simple app lets the user set 
the background and text colour.  When the 
‘Apply’ button is pressed then the background 
and text colour is changed on many 
applications running on the PC. 

http://magnifier.sourceforge.net/
http://www.fx-software.co.uk/assistive.htm
http://www.fx-software.co.uk/assistive.htm
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colours, without having to go through the 
Screen Properties dialogs. 
 

 
Note that the changes are made to a Windows 
file so when this program is stopped the 
background and text colours changed will 
remain and will not revert back to default 
values. 

Rapid Typing (Rapid Typing Website) is an 
application to help the user to learn how to 
touch type. 

 
My Study Bar has version 3.3 and the latest is 5 
from the website. 

When starting, an error message is displayed 
that the app cannot write to the .ini file 
(presumably because it is on a read-only disk).  
Just press ‘OK’ to this and the program will run 
normally. 
 
The drop down menu has a list of letter 
sequences to try to practice to touch type.  The 
fingers of the hands show which fingers should 
be pressing which key. 
 
Due to the program being on a read-only disk, 
any files of lessons or statistics should be saved 
locally preferably on personal memory stick. 

Sonar (fx-software Website) puts a coloured 
circle around the mouse pointer at a 

 
configurable radius, thickness and colour to 
ensure it is visible to users with visual 
impairment. 
 
My Study Bar has version 5 and the website 
seems to only have version 4. 
 

Once started, a ring appears around the mouse 
cursor and an icon appears in the windows task 
box.  To modify the settings, right-click on the 
icon and then choose ‘Settings’.  From this 
menu, you can change the radius, thickness and 
colour of ring around the mouse.  You can also 
choose whether it is a circle or rectangle 
around the mouse. 
 
The help does not seem to work for this app. 

ssOverlay (fx-software Website) allows the user 
to add a coloured tint to the whole screen as

 

Once started, the screen is tinted by the default 
colour and opacity. 
 
To modify the colour and opacity of the tint, 
right click on the icon in the notification area 
and then choose ‘Settings’.  Within this 
window, alter the transparency and colour of 
the tint. 
 

http://www.rapidtyping.com/
http://www.fx-software.co.uk/assistive.htm
http://www.fx-software.co.uk/assistive.htm
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some users experience glare from the screen.  
The opacity and colour of the tint can be 
controlled from the application. 
 
 
 

The help text is not displayed, possibly because 
the app files are on a read-only disk. 
 
To exit the app, right click on the ssOverlay icon 
in the notification area and press ‘Exit’.  This 
restores the display to its original colours. 

T-Bar (fx-software Website) is a coloured bar 
which you can either drag around the

 
screen or lock to your mouse.  It can have ruled 
lines or not, depending on your preference.  
The colour can be chosen from pre-defined 
options, then tweaked by altering the red, 
green or blue sliders to get the perfect colour.  
The transparency level can be adjusted, again 
to suit the individual. 

Once started, a bar appears across the screen 
with a certain colour and opacity.  The ‘T-Bar’ 
icon is also displayed in the notification area. 
 
To configure the height, width, colour and 
opacity of the bar, right-click on the icon in the 
notification area and choose ‘Controls’.  The 
three tabs control the different aspects of the 
bar.  Just press the ‘Done’ button when 
finished. 
 
It is also possible to set whether the bar is 
‘locked’ to the mouse or not but going into the 
icon in the notification area, right-click and 
choose ‘Lock’. 
 
To exit, just right-click the icon and press ‘Exit’.  
When the app closes, the bar disappears. 

Thunder (Screenreader Website) is a free 
screen reader that can be downloaded to your 
PC but which is also included in MyStudyBar.  It 
has won awards. 
 

 
It will also say what options are displayed on 
the screen so the reader can choose one. 
 
My Study Bar has version 2.021 but the latest 
version from the website is 3.06. 
 

Once started, there is a window with two 
buttons on it – ‘Help’ and ‘Settings’.  The 
‘Settings’ will change characteristics of voice 
and actions from some hot keys. 
 
The screen reader seems to only read the title 
bar in Windows programs as well as keys within 
those windows that a user can press.  It does 
not seem to read out load text from a 
document, for example. 
 
‘Webbie’ is a simple web browser where the 
text of pages is read out.  Beware that if this is 
installed then lots of tools will also be installed 
as well that may not be wanted. 

TinySpell (TinySpell Website) is a spell checking 
application that runs in the background and will 
 
 

When started from My Study Bar, it says that it 
cannot load the custom dictionary but if you 
press ‘OK’ then it runs in the background with 
an icon present in the notification area of 
Windows. 
 

http://www.fx-software.co.uk/assistive.htm
http://www.screenreader.net/index.php?pageid=11
http://www.tinyspell.com/
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suggest corrections to words that it suspects 
have been spelt incorrectly. 
 
My Study Bar has version 1.9.20 but the latest 
version from the website is 1.9.60. 
 
There is also another version that can be 
purchased. 

When TinySpell thinks that you have misspelt a 
work, it creates a window with an alternative 
spelling.  
 
No help text seems to be loaded. 
 
This app seems to be mainly for programs that 
do not have a spell checker within them. 

Voice is a very simple voice recognition 
software which may allow the user to dictate 
text to the computer. 

 
 

 

Vu-Bar (fx-software Website) provides an on-
screen, slotted ruler which is useful for readers 

 
with dyslexia, for example, when the reader 
skips lines or drops from one line to the next. 
The application allows the user to modify the 
characteristics of the ruler and the dimensions 
of the slot used to read the text. 

Once started, the virtual slotted ruler can be 
altered by right-clicking the ruler itself and the 
configuration menu is displayed.  This version 
allows the user to select the bar width, 25%, 
50%, 75% or 100% of screen width and set the 
slot height to the required font size. 
 
This app also adds the option to lock the bar 
onto the mouse pointer for movement, as well 
as improved keyboard movement options. 
 
The app can be closed by pressing ‘Exit’ from 
the configuration menu. 

Xmind (Xmind Website) is a free mind-mapping 
tool that also has some project management 
(Gantt charts) software embedded into it. 

 
My Study Bar has Xmind 3 but the latest version 
from the website is Xmind 7. 

It takes a while for Xmind to load up and then 
there is a box with ‘Central Topic’ written in it.  
If you double-click on the box, then you can 
rename it and this becomes the subject of the 
mind map. 
 
Go to the ‘Help’ menu and then to the ‘Xmind 
Help Center’ which is a web page with hints and 
tips of how to create mind maps and use 
Xmind. 
 

http://www.fx-software.co.uk/assistive.htm
http://www.xmind.net/
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The basic program is free but if you want some 
of the more professional features then you 
need to pay. 
 
 

To exit out of this application just go to: 
File -> Exit. 
It may cause an error that it cannot save the 
state but just press ‘OK’ to this and carry on. 

 


